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10 Steps to Getting Started with Cash 
Register Express 

 

 

Your copy of Cash Register Express (CRE) must be registered before use.   To register your software, 

choose Register from the File menu at the Login Screen.  Cash Register Express will prompt you for your 

activation number; enter the serial number located on the side of your CRE box.   

After entering your activation number, Cash Register Express will access the pcAmerica registration server 

over the internet to register your software.   

 

NOTE:  The registration process requires an active internet connection.  If you do not have an internet 

connection, please contact pcAmerica’s customer service department to manually register your software. 

 

For more information see Step 2 of the 10 Steps to Getting Started section of the manual. 
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10 Steps to Getting Started 

Step 1 - Plug in the Equipment 

 

The first step of setting up your point of sale system is plugging in the equipment.   Some of the devices require hardware drivers 

which is what your computer uses to talk to each piece of equipment.   

Step by step instructions on how to plug in your new POS hardware, peripherals and install drivers are located at: 

 http://faq.pcAmerica.com/hardware  

        

 
 

 
 

  

Pole Display 
 
Your Pole Display allows 
customers to quickly and 
easily view their transaction 
as it is being entered into 
the system. 

Cash Drawer 
 
Store cash for the day in 
one safe and convenient 
place.  CRE features an 
antitheft setting to only 
allow employees to ring in a 
transaction with the cash 
drawer closed. 

Barcode Scanner 
 
Scan items effortlessly and 
fast with a bar code 
scanner.   
 
 

Receipt Printer 
 
Receipt printers allow your 
customers to have an 
itemized breakdown of 
their transaction.  CRE will 
also enable you to place 
your company logo and 
bounce back coupon on the 
receipt. 

 

 
For more detailed information about hardware and hardware configurations please see the Hardware Setup section of the 
manual. 

Note:  These are common connection arrangements.  Depending on the equipment you purchased, your connection 
arrangements will vary. 

 

http://faq.pcamerica.com/hardware
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10 Steps to Getting Started 

Step 2 - Install and Start Cash Register Express 

 

Below are instructions on installing Cash Register Express and starting it for the first time.   

You must be logged onto your computer as an Administrator with full access rights in order to properly install Cash 

Register Express. 

 

If you have multiple stations within your store, it is very important that you install the server first!  We also recommend you read 

the Configure Multiple Stations section later in this manual.   

 

If you have multiple stores communicating to a corporate office, it is recommended you sign up for a pcAmerica training session 

to ensure you fully understand the process. 

 

1. Insert the Cash Register Express CD into the CD-ROM drive.  Before 
installing CRE the installer will scan for any prerequisites.  Whatever 
is listed on this screen MUST be installed prior to the CRE install.  If 
nothing on this screen is installed you will get prompted to select ok 
to install everything. 

 

2. After all prerequisites have been installed the CRE installer should 
automatically launch and bring you to the next step.   

3. After the install has completed select Finish to exit the wizard. 

 

4. Select Next to begin the configuration process.  You will be asked a 
series of questions that will determine how your system is installed.  
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10 Steps to Getting Started 

Step 2 – Install and Start Cash Register Express 

 

 

5. Cash Register Express will prompt you to select your industry type, 
select A Retail Store.  Otherwise, choose A Corporate Office for a 
Chain of Stores or Restaurants ONLY IF this computer is an office 
computer in your corporate office (not an office computer in a 
retail store). 

 

6. The next screen in the wizard will be the Database Selection tab. 
 

 Select Configure This Computer to start a NEW database.  To 
connect to your server please see the Configure Multiple 
Stations section later in this manual for more information. 

 

7. You will need to answer a series of questions to help configure your 
system properly. 

 

8. If you are connecting more than one computer in your store to a 
server you must select the right server that station will be 
connecting to. 
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10 Steps to Getting Started 

Step 2 – Install and Start Cash Register Express 

 

 

8. To setup a Store Server you will need to choose the appropriate 

Store ID by highlighting it.  In addition, you need to select a Station.  

For connecting a Station to a Store Server please see the Configure 

Multiple Stations section later in this manual. 

Note: Every station must have a unique number. 

 

9.  After you have configured your system select either Begin or Exit 

and restart the program. 

 

10.  In order to gain access to your new software you must now register 

it.  Select the Register Now tab and scan or enter the registration 

number that came with your software.  You must have an internet 

connection to register your software or call your customer service 

representative (1-800-722-6374 x278) to guide you through the manual 

registration process. 

 

11.  If you are not connecting to a corporate office, Cash Register 

Express will proceed to the Login Screen after a brief loading process.  If 

you are connecting to a corporate office, you will be prompted for the 

corporate office information before progressing to the Login Screen. 

 

 

For a detailed installation guide please see the link below: 

 http://faq.pcamerica.com/maintenance/cre-rpe-installation  

http://faq.pcamerica.com/maintenance/cre-rpe-installation
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10 Steps to Getting Started 

Step 3 - Add Your Employees into the System 

 

Employees are configured within the Employee Maintenance screen of Cash Register Express.  Cashiers and servers must be 

added into the system before they can log in and ring up sales.  Other types of employees can be added and their hours tracked 

within CRE, even if their jobs don’t require them to use the POS.  The steps below describe how to add your initial cashier into 

CRE; the Employee Maintenance section later in this manual will describe additional employee options, job codes and how to 

record employee hours. 

 
1. Select the Manager or Options button. 

2. Enter the administrator password (default: admin) where applicable.   
3. Select Administrative then, Employee Maintenance.  Only the administrator 

can access this screen. 

 

 

4. Select the Add Employee button to create a new employee record.  Assign a 
unique Employee ID (which could be their initials or some other unique 
identifier), password and a Display Name that prints on the receipt.  If you 
would like to assign a secure login card to this employee, swipe the card in the 
Card Swipe ID box. 

 

5. Assign security permissions by selecting the dropdown list and selecting Yes 
(the employee can do this), No (they cannot), Prompt (they can with manager’s 
permission) or Override (they can and are a manager for this function). 

 

For more information see the Top Five Employee Permissions and Uses section of 

the manual. 

 

6. Select the Save button.  Your employee has been added! Add any additional 
employees you wish to configure and then select the Exit button to go back to 
the Login Screen. 

 

For a detailed guide on adding and configuring employees in CRE please see the link below: 

 http://faq.pcamerica.com/software/employees/creating-employees 

http://faq.pcamerica.com/software/employees/creating-employees
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10 Steps to Getting Started 

Step 4 - Configure a Few Setup Options 

 
Cash Register Express has hundreds of built-in features that can be turned on or off.  The Setup Screen includes many of these 
options, organizing them into multiple tabs.  You can access the Setup Screen from the Login Screen by selecting the File menu 
and Setup Screen – you must use the administrator password to enter this screen (default:  admin).  Global settings only need to 
be configured once for all stations while settings that are not global need to be configured once at each station.  Below is a chart 
of recommended feature settings: 
 

Feature Tab Retail Clothing 

Store 

Grocery Store Global 

Prompt Cashier ID, requires a cashier to login for 

every check. 

Invoice Settings X   

Change the Receipt Size to Short Receipt to print 

only the most important information. 

Receipt X X  

Enter the company information that prints on the 

receipt. 

Company Info X X X 

Enter necessary credit card information if you are 

processing credit cards through Cash Register 

Express. 

Payment Processing X X  

Allow credit card swipes on invoice screen will 

allow credit cards to be swiped on the invoice 

screen. 

Station Specifics X X  

Create text that will print on the bottom of a 

receipt as a coupon. 

Couponing X   

Quick Tender will show the amount of change on 

the invoice screen, eliminating a touch from every 

transaction. 

Quick Invoicing & Alerts X X  

Reason Codes allow you to choose a reason why 

you are accepting a return. 

Invoice Settings X X X 

Combine lines items scanned multiple times will 

appear on the same line item. 

Invoice Settings X X  

 

You can read about the other settings and options in the Setup Screen in our F1 Help Section built into Cash Register Express.  
You can also get detailed information about the setup screen from the link below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Setup_Screen.pdf  

 

http://faq.pcamerica.com/file-lockers/pdf-locker/Setup_Screen.pdf
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10 Steps to Getting Started 

Step 5 - Create Your Inventory Items 

 

Your goods are separated into separate groups called Departments.  A few examples of departments are Sweaters, Pants, and 

Fruits.  Departments are used to organize your inventory items on screen as well as on reports.  After your departments are 

created, you create items inside of each of your departments.   

 

To begin creating your inventory items, select the Manager Button on the top right of the Login Screen and enter a username and 

password (default username: 01, password: admin).  Navigate to the Inventory Maintenance screen inside of the Administrative 

tab.   

 

 

To add a new department, select the blue Department for this Item 

link in the top left of the screen.  This will bring you to the 

Department Maintenance screen. 

 

Select the Add Department button, type in a department ID (ex: SWTRS) and description (ex: SWEATERS) and select Save.  After 

adding the department, select Exit to return to the Inventory Maintenance screen. 
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10 Steps to Getting Started 

Step 5 – Create Your Inventory Items 

 

To add a new item, select the Add Item button on the bottom of the Inventory Maintenance screen.  The required information is 

on the top one-third of the screen: 

 The Department this item will be inside of (ex: SWEATERS). 

 A unique Item Number (ex: SW1001, or the barcode of the item). 

 A Description, which will print on the receipts (ex: short sleeve v-neck). 

 Your Cost, which is the price you pay. 

 The Price you charge the customer. 

 An optional # In Stock value if you track stock levels. 

 Various tax options can be selected, if you charge tax for this item. 
 

 

 

Select the Save button and the item will now be added to your inventory list.  See the next step to change the default format of 

your button and customize the touchscreen with your own colors. 

 

 

For a complete breakdown of all options in Inventory Maintenance please see the document below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Inventory_Maintenance_Screen.pdf  

 

For detailed instructions on adding inventory please see the link below: 

 http://faq.pcamerica.com/software/inventory/creating-new-inventory-items  

 

 

  

http://faq.pcamerica.com/file-lockers/pdf-locker/Inventory_Maintenance_Screen.pdf
http://faq.pcamerica.com/software/inventory/creating-new-inventory-items
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10 Steps to Getting Started 

Step 6 – Configure Your Inventory and Function Buttons 

 

The invoice screen, where sales are ring up is a highly customizable screen.  By default, inventory items are displayed in the order 

you add them.  The buttons are added to the screen using a default color.     

 

To change the look of your invoice screen, and configure function buttons and best sellers, select the Manager Button on the top 

right of the Login Screen and enter a username and password (default username: 01, password: admin).  Navigate to the Touch 

Screen Configuration screen inside of the Setup tab and go to the Items & Departments tab. 

 

 

The functions in the Items & Departments tab are used 

to change the order, color, caption and picture of your 

menu buttons.  You can also choose to make certain 

items or departments invisible.  

 To change the color of a department or menu item 
button, select the department (in the left list) or 
menu item (in the right list) and select the Select 
Color button. 

 Change the order of your departments or menu 
items by selecting them from the list and using the 
Up or Down buttons. 

 

When you are finished making changes, select the Save 

& Exit button.  Your saved changes will display the next 

time you log into the invoice screen. 

 

TIP:  Changes made to the inventory screen on one terminal automatically update ALL terminals in real time.  You do have the 

ability to design different screens for specific terminals in your store without affecting the other terminals.  To do this, select the 

Configure This Station Individually option from the Options menu on the top of the screen.   

If this is checked, any layout changes made within Touch Screen Configuration will not affect other terminals. 

 

For a detailed guide on using the touch screen configuration window please see the link below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Touch_Screen_Configuration.pdf  

 
  

http://faq.pcamerica.com/file-lockers/pdf-locker/Touch_Screen_Configuration.pdf
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10 Steps to Getting Started 

Step 7 - Login to the System 

 

Cashiers must login to Cash Register Express before they can ring up customers or enter orders.  The Login Screen prompts 

cashiers for a user name and password, or alternatively the cashier can swipe their card to gain access.  

 

1.  To log into CRE, simply enter your ID and password (the 

default is “01” and “admin”), enter the employees id or 

swipe the secure login card you previously configured in the 

Employee Maintenance screen from Step 3.   

 

2.  Once you have logged in, the CRE invoice screen will 

appear.  Once your system is setup, most of your pos 

experience will take place in the invoice screen.  From this 

screen you can easily access many of the setup options and 

do all of your establishments invoicing.   

 

 

 

 

A secure login card helps prevent one cashier from logging in as a 
different cashier (which is a hole for theft).  Without a secure login 
card, cashiers must type in a user name and password, which is 
visible to others close by.  The only way to log in with the card is 
to swipe the card, protecting the cashier’s cash bank from others 
trying to steal money.  You can purchase these cards from 
pcAmerica directly. 
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10 Steps to Getting Started 

Step 8 - Ring in Some Items 

 

Ringing up an item is easy.  Simply select the TS Lookup button then select the department the item is in (examples: sweaters, T-

shirt, cigars, equipment, etc).  While viewing the inventory for a specific department you can then select the items you would like 

to add to the invoice.  You can also scan the barcode of the item with the barcode scanner (if one has been purchased), the item 

will then be added to the invoice grid automatically. 

 

 

 
 

For detailed instructions on invoicing in Cash Register Express please see the link below: 

 http://faq.pcamerica.com/software/invoicing/general-invoicing-in-cash-register-express 

 
 
  

http://faq.pcamerica.com/software/invoicing/general-invoicing-in-cash-register-express
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10 Steps to Getting Started 

Step 8 – Ring in Some Items 

 

 

If the item is not listed on the touchscreen and it does not have 

a barcode to scan, select the Search button.    

This option lets you search the entire inventory for the item. 

 

At the search screen find the item in your inventory using the many features of filtering inventory described below: 

 On the right of the screen you can select the item type to filter the displayed inventory by. 

 On the bottom of the grid you can use the dropdowns to filter out the inventory based on the Category, 
Department, or Vendor that the Item is part of. 

 At the bottom you can search for the item based on text entered and by how to search through the inventory. 
 After finding the item you would like to add to the invoice, highlight it, click the Select button, and the item will 

then be placed on the current invoice. 

 

For detailed instructions on invoicing in Cash Register Express please see the link below: 

 http://faq.pcamerica.com/software/invoicing/general-invoicing-in-cash-register-express  

http://faq.pcamerica.com/software/invoicing/general-invoicing-in-cash-register-express
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10 Steps to Getting Started 

Step 9 – A Few Basic Every Day Functions 

You can access additional functions by selecting the tabs on the bottom of the invoice screen.  Below is an explanation of each of 
these buttons. 

Note: These buttons can be hidden from the touchscreen by selecting Display Setup from the Setup section of the 
Manager/Options screen.  The Toolbar option is checked it will be displayed. 

 

 

 

F1 – Help a shortcut to the Help section. 
 

F2 – Inventory a shortcut to the Inventory 
Maintenance screen. 

F3 – Clock In/Out a shortcut to the Time clock screen. 
 

F4 – Customers a shortcut to the Customer 
Maintenance screen. 

F5 – Price Check this is where you can check the price 
and stock level of an item. 

F6 – Cash Sale this will ring up the current invoice as a 
cash sale. 

F7 – Check Sale this will ring up the current invoice as 
a check sale. 

F8 – CC Sale this will ring up the current invoice as a 
credit card sale. 

F9 – On Account this will ring up the current invoice 
on account. 

F10 – Cashier Fxns a shortcut that will take you to the 
Cashier Functions screen. 

F11 – Invoice Info a shortcut that will take you to the 
Invoice Properties screen. 

F12 – Item Options this button controls whether or 
not the item options are visible. 

 

 

Item Options 

Delete -- This will delete the currently highlighted 
item on the invoice grid. 

Discount -- This will discount the highlighted item 
on the grid, not the entire invoice. 

Down -- Will scroll down to the next item on the 
invoice grid. 

Up -- Will scroll up to the next item on the invoice 
grid. 

Quan Change -- Will allow you to change the 
quantity of an item on the invoice grid. 

Price Change -- Will allow you to change the price 

of an item on the invoice grid. 

 

 

Void Invoice – This will void the entire invoice. 
 

Hold Invoice – This will allow you to pull up an 
invoice that has been placed on hold. 

 
TS Lookup – This will bring up an on screen layout 

of your items and departments. 
 

Options – This will bring you to the View Options 
screen. 
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10 Steps to Getting Started 

Step 10 - Complete the Transaction 

 

Step 10 is the most important part of the transaction – accepting payment (money) for the goods/services that your 

establishment offers.  The three most common forms of payment in most retail stores are cash, credit/debit cards and gift cards. 

 

 

To pay for a transaction, select the appropriate button 

(PAY).  This will bring open the amount-tendered screen.  

You can also select one of the Quick Tender buttons which 

will bring you to an appropriate screen based on the tender 

type selected. 

CRE also gives the ability to quickly ring in items and put 

them on a customer’s account. 

 

 

 

Cash Register Express’s amount tendered screen is built for speed and 
flexibility.  The default amount is always the exact amount remaining for the 
invoice.  To enter a payment, enter in the amount and select the payment 
method.  If paying by gift card, credit\debit card or check, CRE will ask you 
for more information.  You can also enable one-touch quick payment buttons 
(in the Quick Invoicing & Alerts tab of the Setup Screen) for the most 
common tender amounts.  CRE supports split tendering, meaning you can 
pay with more than one tender type.  

 

SPEED TIP - Pay by credit card without touching a button; our unique swipe-and-go feature allows you to pay by credit card or gift 

card without touching a button.  All you need to do is swipe the credit card on the invoice screen and it will process the card.  This 

is the fastest way to pay.  This option can be configured on the Station Specifics tab of the Setup Screen. 

   

Congratulations!  You’ve rung up your first sale inside of Cash Register Express.  You’ve covered the basics and can now use your 

new point of sale system.  The remainder of this manual includes some useful information for configuring and using your Cash 

Register Express point of sale system. 

 

 
 


